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Section 1 INTRODUCTION AND SETUP 

 

This section introduces NewTek LiveGraphics Creator™, NewTek’s powerful extension for 
Adobe After Effects® that allows you to create colorful LiveGraphics™ – animated title and 
graphic effects that support dynamic realtime playback, control and updating. You will also 
learn about the basic structure of LiveGraphics, and learn how to install and configure the 
LiveGraphics Creator extension. 

1.1 WELCOME 

Thank you for choosing this NewTek™ product.  NewTek is extremely proud of its record of innovation, and 
its commitment to excellence in design, manufacture, and superb product support.  NewTek provides many 
of the most advanced live video tools available, and LiveGraphics Creator™ plays an important role in this 
production ecosystem. 

1.2 INTRODUCTION 

NewTek’s LiveGraphics Creator for After Effects® makes creating animated titles and motion graphics for 
supporting NewTek live video production systems simple and fun. 

 

FIGURE 1-1 

You don’t need to be an After Effects® expert to create beautiful, multi-layered, editable LiveGraphic™ titles 
for your TriCaster or VMC1. LiveGraphics Creator supports two principal ways to create great looking 
LiveGraphics, as discussed in the next section. 
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1.3 TWO WORKFLOWS (ONE FOR ME & ONE FOR YOU) 

1.3.1 SIMPLE 

This approach takes full advantage of LiveGraphics Creator’s automated capabilities to add effects to your 
animated titles and graphics.   

 Begin by importing a layered Photoshop® PSD file into LiveGraphics Creator or, alternatively, by 
bringing an existing After Effects comp into LiveGraphics Creator. 

 Add animation to any of the project’s layers by dropping effect presets included with LiveGraphics 
Creator on them.  Or you can use the SmartBuilder™ feature to make all the decisions for you. 

 In either case, when you are happy with the result, the only additional step needed is to Export it as 
a LiveGraphic title template, ready for use with your NewTek live production system. 

1.3.2 ADVANCED 

After Effects® experts may prefer to manually create an After Effects project that conforms to LiveGraphics 
requirements, and then use LiveGraphics Creator to Export it as a LiveGraphics title, completely ready to use 
with your NewTek live production system. 

Hint: You could use a hybrid method, starting with the simple workflow to save time, then working in After 

Effects to add further animation and fine tuning, finishing up by exporting using the LiveGraphics extension. 

1.4 INTRO, OVER AND OUT! 

LiveGraphics™ aren’t complicated, but do need to conform to a few simple design requirements. Let’s spend 
a few moments to understand their organization. 

Each LiveGraphic template includes one or more graphic layers organized in three consecutive segments 
referred to as the Intro, Loop, and Outro.  Each project layer can have independent animations for bringing 
its text or graphic content (Intro), looping for a period of time (Loop), and then being removed from display 
(Outro). 

Intro Loop Outro 

 
 

After export, the user interface provided for LiveGraphics by supporting NewTek live production systems 
allows you to toggle the visibility of each individual layers (or layer group) manually or by using layer presets.  

 Turning a layer on automatically triggers its Intro animation effect, introducing layer content to view.  
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 When the Intro animation completes, the Loop segment commences, and any animated effects 
applied to that segment (such as a looping rotation, or perhaps an animated glint) begin. 

 A layer’s Loop effect(s) repeats indefinitely until turning the layer off – again, either manually or by 
the application of a preset – invokes the Outro effect. 

 Note that a Loop animation that is underway when the layer is turned off is allowed to complete its 
cycle before the Outro animation plays, typically to remove layer content from view. 

With LiveGraphics’ simple system of intelligent layers, plus easy controls and presets, it’s quite simple to 
deliver complex, overlapping animations that look great but are extremely easy to operate. 

1.5 DISPLAYING LIVEGRAPHICS™  

As mentioned above, NewTek live production systems supporting LiveGraphics make displaying and 
controlling your animated title and graphic pages a breeze. 

Editable text can be 
modified in realtime using TriCaster® or VMC1’s native Title 
Editor (Figure 1-2), which also lets you display or hide the 
individual graphic elements of your LiveGraphic title pages at will. 

In addition, the Title Editor lets you store different layouts as LiveGraphic presets. Recalling these presets 
triggers any number of dynamic layer animations to update the page.  

Hint: Additional native automation features can be employed (for example) to trigger LiveGraphics presets 

when a specific display video source is shown, and much more. 

FIGURE 1-2 
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1.6 DATALINK 

DataLink™ is a NewTek live production technology that uses internal and external data sources to provide 
values for title text and graphics purposes in realtime.  

Complete coverage of DataLink’s features and capabilities is found in the Newtek Automation and Integration 
Guide, available in the Updates and Downloads section of NewTek’s website. We’ll mention here, though, that 
both text and images in LiveGraphics templates can accept DataLink keys as input, and thus can be 
dynamically updated remotely or automatically. 

 

DataLink keys can be inserted into LiveGraphics at the time of their creation, but the integrated Title Editor 
for NewTek live production systems supporting LiveGraphics also lets you enter for keys for text lines and 
replaceable imagery later if you need to. 

A line of text or image set to a DataLink key is automatically replaced by the value currently assigned to that 
key when the LiveGraphic layer containing it is displayed.  There are endless uses for this technology, and a 
wealth of methods to provide and update the values assigned to DataLink keys, including the DataLink web 
browser extension, which makes it easy to populate your title pages over the network from a web browser 
running on virtually any platform. 

See Sections 4.6 and 6.1 for more information on using DataLink in your LiveGraphics projects. 

1.7 GETTING READY 

LiveGraphics Creator™ requires Adobe CC 
2018 software (or better), and computer 
running Windows 7™ or better.  

Note: Before running the LiveGraphics Creator 

extension, ensure you allow network access for 

scripts in After Effects. Otherwise the extension 

will not be able to perform correctly. 



 

Page 11 of 44 
 

1.8 LAUNCH LIVEGRAPHICS CREATOR 

To open the NewTek LiveGraphics Creator extension interface, please proceed as follows: 

 
1. Launch After Effects. 

2. Go to the 'Window' option on the menu bar. 

3. Open the 'Extensions' sub-menu, and enable "NewTek LiveGraphics Creator". 
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Section 2 INTERFACE TOUR 

 

In this section you will gain an understanding of the LiveGraphics Creator™ interface, and its 
primary features.  Whether you will use the simple approach to creating LiveGraphics™, or 
the more advanced workflow (see Section 1.3), this overview of LiveGraphics Creator’s tools 
and features will be help you reach your goals. 

2.1 OVERVIEW 

Let’s take a quick look at organization of major components in the NewTek LiveGraphics Creator interface.  
The major components illustrated above, are listed from top to bottom below: 

 
FIGURE 2-1 

1. Top Bar – Import, Help and Export 

2. Effects – Preset Categories (left pane) and Preset Bin (right pane) 

3. Tool Bar – Clear/Reset All (effects), and Apply All Presets 

4. Layers Pane 

○ Comp Header – Comp headers contain SmartBuilder™ and Apply buttons. 

○ Individual layer rows show 4 cells: Details, Intro, Loop and Outro. 
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2.2 TOP BAR CONTROLS 

2.2.1 MENU 

The top bar menu contains default After Effects panel options as well as a few unique items, discussed next. 

 

 

 

REFRESH PANEL 

After Effects panels are quite flexible in snapping and resizing, but it’s possible to wind up in an unwanted 
configuration. If you see anything odd in the panel layout after snapping or resizing, selecting Refresh Panel 
will usually resolve the issue. (This is not a destructive operation; your comps and presets are not affected.) 

FORCE RENDER TEMPLATE INSTALLATION 

This menu option forces the installation of Render and Output Module presets necessary to for some of the 
extension’s operations.  Normally this occurs automatically the first time you run, so this option should really 
only be necessary if an unexpected error occurs and customer support recommends its use.   

Note: Using this menu item will also close your current project.  

2.2.2 IMPORT PSD FILE 

 

The large button labeled Import PSD File automatically creates a new After Effects® composition from a 
layered Photoshop® file you choose.  To begin, you might load one of the PSD files supplied with LiveGraphics 
Creator. 

Note: PSD layer names must be unique to avoid issues later. Also, be aware that any open projects will be 

closed when you import a PSD. 

By the way, these files are the same ones used by NewTek to create the included LiveGraphics, and you can 
easily customize them in art software (to use corporate or sports team colors, for example). 

FIGURE 2-2 
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2.2.3 HELP 

Press the Help button located in the center of the top bar to view 
this help file in your system PDF viewer. 

 

2.2.4 EXPORT LIVEGRAPHIC 

After adding effects to the layers of your project, pressing the Export LiveGraphic button will compile your 
composition to a LiveGraphic file (with the filename extension “.LiveGfx”) and folder for used your video 
production. 

2.3 EFFECTS PANES 

Two large Effect panes sit Just below the top bar, and these are discussed next (see Figure 2-1). 

2.3.1 PRESET CATEGORIES 

 

Effect presets are grouped in 
various categories by type as 
well as their intended 
application.  These are displayed 
in the large Preset Categories 
pane at left just below the top 
bar. 

For example, the Intro – Text 
categories are further sub-
divided in presets that affect text 
elements at the character, word, 
or line level.  Effect presets for 
the Loop and Outro segments of 
your LiveGraphic composition 
are group in similar fashion. 

2.3.2 PRESET BIN 

The individual effect presets belonging to the selected category are listed on in the Preset Bin the right hand 
side. The icons in the Preset Bin represent the various animations you can apply to the composition’s layers.  

FIGURE 2-3 

FIGURE 2-4 

FIGURE 2-5 
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Simply drag a preset icon from the Bin onto the appropriate time segment cell (Into, Loop or Outro) of a layer 
below to assign the corresponding effect to that layer. (We’ll discuss this layers further in a few moments.) 

2.4 3. TOOL BAR 

A Tool bar sits just below the Effects panes, and above the Layers panel. 

2.4.1 GET COMP DATA – CLEAR/RESET ALL 

The first button in this central toolbar serves several purposes, and can appear differently depending on the 
current state of your project. 

If you have already loaded an After Effects project before launching LiveGraphics Creator, LiveGraphics 
Creator needs to be informed about the layer structure of your composition before you can proceed.   

In this case, press Get Comp Data to scan for compositions in your After Effects project, and populate the 
LiveGraphics Creator’s Layers pane.   

This step is not necessary when you being your LiveGraphics Creator session using the Import PSD File button, thus 

this button appears in its Clear/Reset All guise, discussed next. 

Note: PSD and AE project layer names must be unique, even if they are in separate groups or comps. 

FIGURE 2-6 

FIGURE 2-7 
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Once layers are present in LiveGraphics Creator, whether because you clicked Get Comp Data or loaded a 
Photoshop file, clicking Clear/Reset/All presents the following dialog box. 

 
FIGURE 2-8 

 
FIGURE 2-9 

LOAD DATA 

Load Data can be used to reload comps and layers (complete with previously assigned LiveGraphics presets) 
from the current After Effects project – typically an unfinished LiveGraphics project you wish to continue to 
work with.   

Note: Time segments for layers that don’t match data found in the current project loaded will be cleared. 

CLEAR ALL 

Click Clear All to remove all presets currently applied to the LiveGraphics Creator project’s layers. 

2.4.2 APPLY ALL PRESETS 

Click Apply All Presets to update the layers in your After Effects project, adding keyframes and settings to 
layers corresponding to the effect presets you’ve added in LiveGraphics Creator.  (We’ll talk about this in 
more depth a bit later.) 

 

FIGURE 2-10 
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2.5 LAYERS PANE 

The Layers pane lists of all the compositions and layers loaded in LiveGraphics Creator (compositions are 
distinguished from individual layers by the folder icon shown at left beside their label).   

Clicking a comp header row expands it to reveal its nested layers below, or closes it to hide them. We’ll 
explore the Layers panel and its features in full detail in the next section.  

FIGURE 2-11 
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Section 3 SIMPLE WORKFLOW 

 

By far the easiest way to create complex LiveGraphics™ uses LiveGraphics Creator’s ability 
to quickly add effects chosen from supplied effects presets to the layers of your title and 
graphic compositions.  Appropriate effects to display and remove individual layers can be 
assigned automatically with a single click, or you can manually choose effect presets. 

Having begun by importing a PSD file (see Section 2.2.2), you’re ready to continue the creation process. 

LiveGraphics Creator’s Layers pane, discussed in the previous section, provides two different ways to apply 
effect presets.  The first of these is SmartBuilder™, which offers what is often the easiest and fastest approach.  
Of course you may well want to take more direct control, or use a hybrid approach.   

All of these matters are explained in the following sections. 

3.1 COMP HEADER TOOLS 

The Comp header contains just two buttons, both located at right – SmartBuilder™, and Apply.  The latter is 
similar to Apply All Presets, but more limited, applying just the effect presets for layers nested inside that 
specific comp) to the corresponding After Effects® layers.  Let’s jump into SmartBuilder next. 

3.1.1 SMARTBUILDER™ 

 

SmartBuilder™ is an amazingly quick 
and completely automatic way to add 
effects to your LiveGraphics project.   

When you click the SmartBuilder button, 
LiveGraphics Creator automatically 
performs the following operations: 

 The layers nested in the selected 
comp are parsed to determine 
their respective types, since this 
governs which effect presets can 
be applied to the various layers.  
 

 Then, SmartBuilder applies 
random effect presets to the 
Intro and Outro time segments of 
each layer, always respecting the 
layer’s type. 

FIGURE 3-1 
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The entire process takes a matter of seconds to produce amazing results.  You might choose to simply accept 
the animated effects as-is for a quick turnaround project, or use it as a starting point for further refinement. 

3.1.2 DRAG AND DROP PRESETS 

As cool as SmartBuilder is, at times you will 
want to choose one or more specific effect 
presets for the Intro, Loop, and Outro time 
segments of your project layers.   

This process is exceedingly simple.    

Just make a selection in the Preset Category 
pane (see Section 2.3.1, and locate a suitable 
entry in the Preset Bin. 

Drag the icon for the preset onto one of the 
three cells representing the Intro, Loop, or 
Outro time segment for the target layer. 

Hint: Time segment cells prevent you from dropping unsuitable effect presets types onto them. For example 

you can’t drag an Intro effect preset onto an Outro cell, or a text preset onto a graphic layer. 

 

3.2 OPTIONS 

3.2.1 DELAY AND SPEED 

Click a cell for a specific time segment (Into, Loop or Outro) in a row in the Layers panel to open an options 
window for that layer and time. 

DELAY 

The Delay setting lets you specify an offset (in frames) to elapse before 
this motion preset is applied. The delay begins when the operator enables 
or disables the layer’s visibility. When the delay time elapses, the effect 
preset runs. 

Generally this is used to 
offset a layer’s ‘arrival’ or 
‘departure’, or to sequence a 
series of layers in succession. 

You might often to use this 
feature to add drama when 
controlling the visibility of 
many layers at once 
(whether manually or by 
using a Layer Preset or macro to 
control the display in one of NewTek’s live production systems such as a TriCaster). 

FIGURE 3-3 

FIGURE 3-2 
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LINKED DELAY 

If you enable the Linked Delay option for a layer, that layer first waits patiently until the delay applied to the 
layer directly above it concludes. Only then does its own local delay countdown begin. 

 This option is great when you 
want to animate specific layers 
sequentially – as, for example, a 
bulleted list of text items.  

You would select the appropriate 
text layers, link their delays, and 
then set the delay to the desired 
length.  Each layer will then 
animate in (or out) one after the 
other.  

Of course, since Linked Delay is 
relative to the neighbor directly 
above, the offset effect 
accumulates when successive 
layer have it enabled.  

For example, if three layers each with Delay settings of 10 frames have Linked Delay enabled, the first layer’s 
effect is delayed 10 frames, the next is delayed 20 frames, and the last layer’s delay becomes 30 frames. 

SPEED 

This control (Figure 3-5) allows you to specify how fast or slow from the 
original speed to play the motion preset. Presets are typically, though not 
always, designed to be 2 seconds/60 frames long at 100% speed. 

3.3 MULTI-SELECTING LAYERS 

Selecting a layer and with the Shift key pressed allows you to multi-select a 
range layers. Click layers while holding down CTRL to select/deselect 
discontinuous layers.  And of course, press CTRL+A to select all layers. 

Hint: Dragging an effect preset onto multi-selected layers assigns it to all layers, 

unless the preset is not valid for that layer or time segment. 

  

 

FIGURE 3-4 

FIGURE 3-5 

FIGURE 3-6 
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3.4 APPLY PRESETS 

Once you finished editing layer effects, you need to apply your preset animations to the After Effects project 
by either clicking: 

 "Apply All Presets" (spoiler alert: this applies ALL presets you currently have configured in 
LiveGraphics to the corresponding compositions loaded in After Effects™).   
 

 Or you can limit the application to preset effects in individual compositions by 
clicking the ‘Apply’ button on each composition in the layers list. 

3.4.1 PREVIEWING EFFECTS 

Having applied the effect presets to the After Effects® project layers, you can use After Effects’ preview 
features to review your work in the composition window. 

The last presets you apply to 
layers are stored with the 
layer, and saved with your 
After Effects® composition.   

Unapplied presets and settings 
are likewise retained through 
simply closing and opening the 
window. As long as your comp 
and layer order has not 
changed, everything remains 
in sync.   

However, if you add, remove, 
reorder or change any layers, 
click Reset/Reset All in the 
Tool bar above the Layers 
pane, and perform an Update 
Comp operation to pull your 
revised After Effects® composition into LiveGraphics. 

Hint: Conveniently, while After Effects® remains open, you can safely close the LiveGraphics Creator panel 

without losing anything, then reopen it later in your session to continue. 

FIGURE 3-7 

FIGURE 3-8 

FIGURE 3-9 



 

Page 23 of 44 
 

3.5 EXPORTING LIVEGRAPHICS 

After fully configuring your LiveGraphics Creator project, the last step is to export your composition to a 
LiveGraphic file (.LiveGfx) and associated folder to load onto your NewTek™ live production system. 

Clicking the Export button presents a dialog that lets you supply a name for the exported LiveGraphic file, 
and choose a location to save it.   

The panel lets you export one comp at a time, using the menu at the top of the Export LiveGraphic dialog to 
choose which project to process. 

 
FIGURE 3-11 

3.6 INSTALLING LIVEGRAPHIC TITLES 

We recommended placing exported LiveGraphic files and folders generated by the export process into a 
specific location on your live production system (so that they will appear in the custom Media Browser 
without any extra effort.)  This location can be found be found by typing %programdata% into the address 
bar in a Windows Explorer window on the target system. 

Inside this folder, navigate to:  /NewTek/Media/LiveGraphics/. We recommend making a ‘User’ folder here, 
and copying your files into it. (This isn’t a requirement, is useful for organizational purposes as a good way 
to distinguish your files from others on the system.) 

Each “LiveGraphic” consists of one file and one folder of associated content. Both are required, in the same 
location, for the LiveGraphic export to work correctly on your switcher. For instance, if your LiveGraphic is 
called “Lower Third”, the Export function will create a file called “Lower Third.LiveGfx” and a folder called 
“Lower Third”.  Copy both of these into your destination folder.  Subsequently, you’ll find your new 
LiveGraphic in the “User” folder under the LiveGraphics heading when you use the system’s Media Browser. 

FIGURE 3-10 
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Section 4 ADVANCED WORKFLOW 

 

This section provides the details you need if you wish to work directly in After Effects™ tools 
to design custom layer effects and create more advanced LiveGraphics™ titles.  Or, you might 
want to use a hybrid workflow, using After Effects® to and features to add finishing touches 
to a composition you prepared using the simple workflow discussed previously. 

 
As we’ve seen, you can begin with a simple layered Photoshop file and get amazing results easily using the 
simple workflow discussed in Section 3.  More experienced artists wanting full control can also use After 
Effects® native features to create dynamic animations designed to meet LiveGraphics™ specifications, then 
export these as LiveGraphics titles using the LiveGraphics Creator™ extension. 

Numerous ready-to-use LiveGraphics titles are included with LiveGraphics Creator.  Advanced users will also 
appreciate the inclusion of the actual After Effects® projects and Photoshop PSD files used to create these as 
part of the content.   

Let’s review some background information you will find important when using this more involved workflow. 

Hint: The next major section provides a hands-on example you can follow. 

4.1 STARTING A PROJECT 

To begin your title project, you can use After Effects' native drawing and text tools to prepare layer content, 
or do so in Adobe Photoshop® and import a layered PSD file into After Effects® as discussed previously.  Note 
that any item you intend to animate needs to be on its own layer in Photoshop® or After Effects®. 

4.2 LAYERS 

Each layer in the exported composition in After Effects® will ultimately be listed in the TriCaster or VMC1 
Title Editor as a layer whose visibility state can be toggled.  For layers with animation, hiding or showing the 
layer triggers its associated (Intro or Outro) animation – see Sections 1.4 and 1.5. 

To reduce up the number of layers that appear in the Title Editor, items that are part of the same graphic 
element in your design can be grouped into a pre-comp.  The pre-comp name will listed as a single layer in 
the Title Editor window. 

4.3 INTRO, LOOP, AND OUTRO MARKERS 

After establishing the basic graphic design elements of your project, you need to define the places in time 
where title animation begins (the Intro), loops (or remains static) until removed from view, and when it ends 
(the Outro). 

After Effects markers are generic layer properties that let you mark a certain place in time on a layer, or on 
the timeline itself.  NewTek LiveGraphics Creator uses markers to identify the beginning and end of the Loop 



 

Page 26 of 44 
 

segment (the start of the composition marks the start of the Intro, and the end of the timeline denotes the 
end of the Outro). Any further markers are ignored. 

 

FIGURE 4-1 

When making a LiveGraphic by hand, you need to place these markers – in the same place for all animated 
layers - in order for LiveGraphic Creator to identify these vital time segments.   

Hint: If a layer has no markers set, it can still be turned on and off in the switcher.  Such layers will simply loop 

continuously whenever the layer is visible. 

4.4 BAKED LAYERS 

Common layer properties, such as transforms, opacity, layer masks, track mattes, as well as the 'Color 
Balance (HLS)' effect for animating color are supported.  However, After Effects® pixel filters (such as Blur, 
Levels, and Advanced Lightning that appear in the Effects menu) cannot serve as real-time LiveGraphics 
effects. 

Any unsupported effects or property changes you apply to layers will result in that layer being 'baked' into 
rasterized frames. In consequence, these layers will no longer be editable after export as a LiveGraphic.   

Hint: If you find a layer cannot be edited after export, try removing any effects applied and re-exporting. 

Thus for maximum flexibility, you will want to avoid unsupported effects for anything that you might later 
want to change dynamically in your LiveGraphic title. 

Hint: Most Layer Styles (effects such as Drop Shadow and Glow, accessed through Layer > Layer Styles) can be 

used on graphic and text layers and remain editable.  However, only the starting parameter of the style is 

respected. So, for example, if the distance or angle of a Drop Shadow is animated, the animation will not be 

preserved on export.  

As another example, layer transforms such as position, scale and rotation to position your text in 3D space 
work fine and allow text editing later. However, using the Distort > Corner Pin effect to place a piece of text 
would force the layer to be rasterized during export.   

4.5 FONTS 

Any fonts you use in your title design must also be available on the target live production platform.   
Otherwise, they will be replaced with Arial.  The Title Editor depicts missing fonts in red in its font selector. 
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4.6 DATALINK KEYS AND REPLACEABLE IMAGES 

Text layers that have Datalink keys entered rather than (or along with) static text strings will be replaced by 
the current Datalink value, if any, upon display by TriCaster/VMC1.   

Similarly, image layers with the string “REPLACEABLE” (without quotation marks) in their layer name 
become replaceable in the Title Editor on the NewTek live production system. These replaceable image 
layers also support the addition of a Datalink key to the layer name.   

When a replaceable image also has a DataLink key in its layer name, the image will automatically display to 
the corresponding Datalink image value when displayed (on the live production system), and will update 
dynamically whenever the image key value is modified. 

4.7 THIRD PARTY AFTER EFFECTS® TEMPLATES 

You can download template files from websites such as Videohive, etc. but please note that these templates 
can be setup in many different ways depending on how the author designed them. Very often, substantial 
adjustments will be needed for them to fulfill the LiveGraphics requirements discussed earlier in this chapter. 

For example, should a template use an expression to modify unsupported properties, these will need to be 
removed to avoid unexpected results.  (Expressions affecting supported layer properties should work just 
fine, of course.) 

It's virtually impossible for LiveGraphics™ to mimic everything that can be accomplished with the near 
endless number of After Effects® plugins available, so a similar caveat applies to unsupported Effect plugins.  
These layers will be baked when possible but, depending on the plugin’s internal operations, these effects 
may need to be removed altogether.  

4.8 GET COMP DATA AND EXPORT 

As we’ve seen the LiveGraphics Creator extension allows you to import Photoshop® files as a starting 
template, or you can use animated After Effects® templates you create yourself or download from online 
stores to prepare LiveGraphics titles for export. 

In the latter cases- having modified the After Effects® with the various LiveGraphics requirements discussed 
in this section in mind – you would then use the Get Comp Data feature to read the After Effects® composition 
into LiveGraphics Creator™.  Finally, you would then select a comp to convert to a LiveGraphics title using 
LiveGraphics Creator’s Export function. 
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Section 5 PROJECT EXAMPLE 

 

In this section, we’ll walk you through an actual example of the advanced workflow discussed 
earlier.  You’ll use After Effects® features to prepare a project suitable for import into by 
LiveGraphics Creator ™ using its Get Comp Data feature, and then export the result as a 
finished LiveGraphics™ title ready for use. 

 
Let's take a walk through turning a static layered Photoshop® file into an animated LiveGraphics title. 

5.1 PREPARATION 

5.1.1 IMPORTING THE PHOTOSHOP FILE 

The Photoshop® file we’ll use for this project is ‘Hexagon Lower Third’, included with the LiveGraphics 
installation.  The elements of this graphic are shown in Figure 5-1. 

 
FIGURE 5-1 

1. Launch After Effects®. 

2. Select the New Composition From Footage option (Figure 5-2) when After Effects first starts, or by 
going to ‘File > Import > File…’ to import the Photoshop® file into After Effects®. 

Hint: Alternatively, you can skip the next few steps by using LiveGraphics Creator’s Import PSD button to do 

this for you – see Section 2.2.2).  
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FIGURE 5-2 

3. When presented with the file browser, select the options shown in Figure 2-2. 

 
FIGURE 5-3 

4. After importing the file, you will be presented with the following dialog box.   

Configure it as shown in Figure 5-4, and click OK to import your file. 

 
 

 

FIGURE 5-4 
FIGURE 5-5 
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5.1.2 GROUPING / NAMING LAYERS 

The layers in the original Photoshop® file are arranged as shown at left below (Figure 5-6). 

  
 
After importing into After Effects®, any layers that were nested in Photoshop® folder groups appear as pre-
comps (Figure 5-7) 

Conveniently, this can be help you to control the naming of various elements of your composition, saving you 
the trouble of editing layer names later in After Effects®.   (Of course, single layer items don’t need to be 
grouped unless it sits your design requirements.) 

 

 

 

 

FIGURE 5-6 
FIGURE 5-7 
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5.1.3 SETTING YOUR COMPOSITION LENGTH 

Setting your composition length at the 
start lets you see how much ‘space’ you 
have to work as you add keys for animation 
you add to the project.  (Strictly speaking, 
this step is optional – but we recommend 
doing so.) 

 

5. In After Effects, display the 
Properties dialog for your main 
composition and set project 
Duration to something suitable, as 
shown in Figure 5-8. 

5.1.4 CONVERTING TEXT LAYERS 

When importing files from Photoshop, you 
need to convert text layers you intend 
them to remain as editable in the resulting 
LiveGraphics™ title. 

 

6. Select the text layer(s) in After Effects®, right-click to bring up the context menu and, finally, select 
the Convert to Editable Text menu item. 

 

FIGURE 5-9 

FIGURE 5-8 
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5.2 ANIMATION OPTIONS 

We’re now ready to start animating our title design. In this title example, we want all of the various layers to 
be revealed in an interesting way, as if it’s building itself. 

5.2.1 LAYER MASKS 

If you have elements in your design that you wish to reveal in place which are neither rectilinear nor circular 
(and thus which cannot be easily revealed by animating scale or position), you might want to use masks. Our 
example title design requires this as it includes lots of irregular shapes. 

Hint: Masks are useful for creating effects applied to the Loop section of your title. For example, it’s very easy 

to apply a looping highlight flash to one or more graphic elements. 

Let’s create a gradient to use as a ‘highlight flash’.  This gradient will be masked by the Divider layer for use 
in the Loop portion of our title design.  

7. First, open up the Background pre-comp. 

 

8. Using the After Effects® ‘Rectangle Tool’ found on the top toolbar, draw out a rectangle to the left of 
the lower third to create a gradient that fades in and out horizontally: 

9. Rename Shape Layer 1 to “Highlight Fade” to make things easier to remember.  

FIGURE 5-10 
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10. Next, duplicate the Divider layer, rename it “Highlight Fade Mask”, and drag it above the Highlight 
Fade (gradient) layer. 

 
11. Assign the Highlight Fade Mask layer as a mask for the Highlight Fade layer by changing the latter’s 

Track Matte mode to Alpha Matte “Highlight Fade Mask” (Figure 5-11). 

The Highlight Fade layer is now 
masked by the Highlight Fade 
Mask (a copy of the Divider 
layer), so that the gradient is only 
visible within the ‘Divider’ 
portion. 

 Let’s continue to create Shape 
Masks for all of the other layer 
appropriate items, starting with 
the ‘Left Line’ layer.  

12. Use the ‘Rectangle Tool’ 
drag a rectangle to cover all of the elements 
you wish to reveal, then (as before) give this 
new layer the same base name as the element you 
intend to mask, appending the suffix “mask” to it (to avoid any confusion later) – see Figure 5-13. 

13. Repeat these steps as required for all the other elements in your title, except any layers or elements 
that use basic transforms or don’t require masking for other reasons. 

 

FIGURE 5-12 

FIGURE 5-11 

FIGURE 5-13 
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Note: To ensure that each element in the title scales from the direction you intend, you may need to adjust 

each layer’s Anchor Point.  To do so, select each layer in turn and use the Pan Behind (Anchor Point) tool from 

the top menu bar (Figure 5-15). 

 
5.2.2 LAYER PROPERTIES 

We now have all the necessary elements ready to animate in interesting ways, either by scaling the masks to 
reveal portions of the title, or directly animating properties such as opacity or scale (Figure 5-16). 

 

FIGURE 5-14 

FIGURE 5-15 

FIGURE 5-16 
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We won’t delve into the fine details of how to animate various After Effects™ properties.  There are ample 
online learning resources if you need help in this area.   

However, as they play such a vital role in title animations, let’s take a moment just to look at text layer effects 
just a bit more.  In this simple example, we’ll animate the opacity of the individual characters in a text layer. 

14. Click the arrow next to Animate on each text layer and select Opacity 

15. Expand the fold-down arrows on the text layer, Text property, Animator and Range Selector to reveal 
the layer’s properties (Figure 5-17).  

16. Create key frames to reveal the text by animating the Range Selector’s Start property, setting the 
Opacity value to 0%. 

 

Once you have added Intro animations to as many layers as you want to, you’re ready to consider Outro 
effects.  One very fast way to create the Outro is to simply copy the Intro keys for each layer to the Outro.  

Then select the copied keys, right-click any key, and select Keyframe Assistant > Time-Reverse Keys from the 
menu.  This will reverse the Intro keys for each layer to create a matching Outro effect. 

FIGURE 5-17 
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5.2.3 LOOP MARKERS 

After preparing all the visual elements of your LiveGraphics title design, you need to identify the Intro, Loop 
and Outro segments of your LiveGraphics title design (see Section 1.4).  This really only requires adding After 
Effects® layer markers to mark the start and end of the Loop segment.  (Obviously, everything before the 
Loop start is Intro, and everything after the Loop ends is Outro.) 

This simply requires you, then, to proceed as follows: 

17. Select all layers of your main, top-level comp 

18. Locate the last keyframe in any layer in the Intro section, and add a marker there.  

19. Likewise, find the first Outro keyframe in any layer, and add a second marker there. 

 
You’re almost done – just one more step to go. 

5.3 EXPORT 

With your title animation complete in After Effects®, you are ready to export it as a LiveGraphics title.  

FIGURE 5-18 

FIGURE 5-19 
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20. If it isn’t already open, display the LiveGraphics Creator™ extension interface. 

 

21. Click the large Get Comp Data button to import the top level comp for your After Effects project into 
the LiveGraphics Creator™ pane. 

22. Then click export to show the dialog that lets you choose which comp to export, supply a name for 
the exported LiveGraphic file, and choose a location to save it.   

  
Your compiled LiveGraphics files will comprise a file with the .livegraphics filename extension, and a folder 
containing the supporting files.

FIGURE 5-20 

FIGURE 5-21 
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Section 6 SUPPLEMENTAL TOPICS 

 

In this final section we will add information that is not strictly necessary to create functional 
LiveGraphics™ titles, but which can help you take full advantage of their capabilities, 
drawing on tools and features that are common in the NewTek product ecosystem. 

 
The following section provides useful information about additional advanced topics. 

6.1 MORE ON DATALINK & REPLACEABLE IMAGES 

LiveGraphics™ text layers that have Datalink keys entered rather than (or along with) static text will be 
replaced by the current Datalink value, if any, upon display by TriCaster/VMC1. 

Similarly, image layers with the string “REPLACEABLE” (without quotation marks) in their layer name 
become replaceable in the Title Editor on the NewTek live production system. These replaceable image 
layers also support the addition of a Datalink key to the layer name. 

Hint: When loaded for display in your production, the REPLACEABLE label is stripped out, leaving just your 

desired layer name. 

When a replaceable image has a DataLink key assigned as described above, the image will automatically 
display to the corresponding Datalink image value when displayed (on the live production system), and will 
update dynamically whenever the image key value is modified. 

 

FIGURE 6-1 

In the example above you can see the key %Session Title Image% applied to an After Effects® layer. 
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Hint: If you begin your project by importing a Photoshop® file, you can pre-enter the REPLACEABLE keyword 

and DataLink keys for the layers right in Photoshop.  As you’d expect, these name values are preserved on 

import into After Effects®. 

6.1.1 DATALINK BROWSER EXTENSION AND MORE 

The list of DataLink sources is quite long, and even includes third-party applications. One of the most 
interesting sources of DataLink key/value pairs is a custom extension prepared by NewTek for the Chrome® 
web browser.  Available without charge from the Chrome Web Store, DataLink™ Web allows you to easily 
populate both text and image DataLink keys from webpages. 

 

FIGURE 6-2 

The DataLink keys and values are immediately available for use in NewTek live video mixer title pages, and 
elsewhere in the NewTek live video mixer.  Simply select some text, or an image, and use the right-click 
context menu (or a hotkey) to update a DataLink key you have defined. Any title page using that key will 
immediately update. 

6.2 LIVEGRAPHICS™  PRESETS 

NewTek live production systems supporting LiveGraphics offer two different types of presets to control title 
animations and title content.  These are referred to as Layer Presets and Data Presets, respectively.  Both 
preset types are created using the Title Editor (Figure 6-3) on the target system. 
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FIGURE 6-3 

The documentation supplied with your TriCaster or VMC1 describes the Title Editor, and explains how to 
create and use Layer and Data Presets to manage the display, content and animation of your LiveGraphics.  

6.2.1 EMBEDDING PRESETS 

It takes time to prepare suitable presets for your LiveGraphic titles, and you won’t want to have to do this 
each time you load one into a new live production session. 

For this reason, you will very often want to save LiveGraphics with presets already embedded into them.  
Then, the next time you load your title they are all ready to go.  

To store presets you have prepared, click the ‘Export…’ button in the Title Editor and save the LiveGraphic.  
You can export your work under a new name, or overwrite the original. 

Hint: Data Presets are very useful.  For example, you can populate ‘player statistics’ title pages for the entire 

team, and export the file, and then display each instance with a single click as desired.  Prepare a similar page 

with player data (and headshots) for a second team, and export it using a different filename. 
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